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SecureBoot Windows 2026 Dodawanie Certyfikatow dla wybranych
SYSTEM  roduktow NTT

Wstep:

Microsoft od 2026 roku wymaga, aby w urzadzeniach wspierajacych Windows 11 znajdowat sie nowy certyfikat,
pozwalajacy na uruchomienie systemu. Jesli Twoje urzadzenie zostato wyprodukowane przed 2026 i zauwazysz
ponizszy komunikat, odwiedz portal https://ntt.pl/support/ lub https://support.ntt.pl/ nastepnie wpisz numer
seryjny urzadzenia w celu zweryfikowania czy dostepna jest nowa wersja oprogramowania uktadowego zawierajaca
wymagang poprawke.
*Tylko dla wybranych urzadzen NTT.

Aby sprawdzi¢ czy twoje urzadzenie zawiera poprawne certyfikaty nalezy uruchomic jako administrator aplikacje
Power Shell:

O\

& » Apps Documents Settings

Best match

Windows PowerShell
|,

Nastepnie wklei¢ do konsoli ponizszy tekst:
[System.Text.Encoding]::ASCIl.GetString((Get-SecureBootUEFI DB).Bytes) -match 'Windows UEFI CA 2023’
[System.Text.Encoding]::ASCIl.GetString((Get-SecureBootUEFI DB).Bytes) -match 'Microsoft UEFI CA 2023’

[System.Text.Encoding]::ASCIl.GetString((Get-SecureBootUEFI KEK).Bytes) -match 'Microsoft Corporation KEK 2K CA
2023’

Jesli w konsoli pojawi sie komunikat ,, True”- twoje urzadzenie posiada wymagane certyfikaty i nie trzeba
przeprowadzaé ponizszej aktualizacji. Jesli pokaze sie ,,False”- zapoznaj sie z ponizszymi wytycznymi.

O M Administrator: Windows Powe X + v

Windows PowerShell
Copyright (C) Microsoft Corporation. All rights reserved.

Install the latest PowerShell for new features and improvements! https://aka.ms/PSWindows

True

PS C:\Windows\system32> [System.Text.Encoding]::ASCII.GetString((Get-SecureBootUEFI DB).Bytes) -match 'Windows UEFI CA 2
823!

PS C:\Windows\system32> [System.Text.Encoding]::ASCII.GetString((Get-SecureBootUEFI DB).Bytes) -match 'Microsoft UEFI CA
223"
True

Ps u:\Windows\system32> [System.Text.Encoding]::ASCII.GetString((Get-SecureBootUEFI KEK).Bytes) -match 'Microsoft Corpor
ation KER 2K CA 2023'
True

PS C:\Windows\system32>

Jesli po uruchomieniu urzadzenia zauwazysz ponizszy komunikat (*lub podobny, ale z tytutem SecureBoot Violation
na czerwonym tle) zastosuj sie do dalej wymienionych wytycznych.

Secure Boot Violation

Invalid signature detected. Check Secure
Boot Policy in Setup
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Odtacz wszystkie urzagdzenia podtaczone do portéw USB (z wyjatkiem myszki i klawiatury), nastepnie wykonaj

ponowne uruchomienie urzadzenia.

Sprawdz czy w portalu Support znajduje sie poprawka dla twojego urzadzenia
Jesli znajduje sie plik z poprawka, zrestartuj urzadzenie na ktérym wystepuje komunikat o naruszeniu
SecureBoot. Podczas ponownego uruchamiania od razu zacznij wciska¢ klawisz ,,Delete” znajdujacy sie na

klawiaturze. To pozwoli wejs¢ do ustawien BIOS.

Przejdz do zaktadki Security:

Ad

Aptio Setup - AMI

Security | Boot

2 Exit

BIOS Information
Model Name

Build Date and Time
Access Lewvel

Sustem HManufacturer

Odszukaj i uruchom funkcje ,,Secureboot”:

Main Advancec Chipset ESURIYM Eoot Sawve

Aptlo Setup - AMI
& Exit

Disable Block Sid [Disable]

Password Description

If ONLY the Administrator's password is set,
then this onlyu limits access to Setup and is
only asked for when entering Setup.

If OMLY the User's password is set, then this
is a power on password and must be entered to
boot or enter Setup. In Setup the User will
have Administrator rights.
The password length must be
in the following range:
Hinimum length

Maximum length

27

20

Administrator Password
User Password

Check PassHord [Always]

Przetacz ponizszg funkcje z ,,Enabled” na Disabled:

PH610-D4 w2.0
01741542025 12:35:52
Acdministrator

NTT System S.A.

Security
System HMode User
Secure Boot [Enablel
TActive
» Restore Factory Keus
» Reset To Setup Hode
l' Key Hanagement
Aptio Setup - AMI
Security

Suystem Mode User

Secure Boot HMode
» Restore Factory Keys
lv Reset To Setup HMode

[Standard]

> Key Management
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Zapisz ustawienia klawiszem ,,F10”.

Urzadzenie po ponownym uruchomieniu zataduje system operacyjny Windows (bez czerwonego komunikatu), tym
samym mozliwe jest uruchomienie oprogramowania do aktualizacji BIOS, pobranej z portalu Support. Dalsze kroki
aktualizacji zawarte s3 w oprogramowaniu do aktualizacji oraz w dokumencie PDF dostarczonym z aplikacja.
*Jesli komunikat nadal jest widoczny pomimo przetaczenia funkcji na ,,Disabled” i zrestartowaniu urzadzenia-
sprawdz czy Status funkcji zmienit sie na, Not Active”:

Aptio Setup - AMI

Security

System HMode User

I Notvéctive |

Secure Boot HMode [Standard]
» Restore Factory Keys
» Reset To Setup Hode

» Key Management

Jesli widoczny status to , Active”. Wykonaj ponownie powyzsze kroki.

Po aktualizacji BIOS funkcja Secureboot automatycznie sie aktywuje z poprawnymi dla Windows 11 2026
certyfikatami oraz komunikat o naruszeniu SecureBoot powinien zniknac.
Nie jest wymagane ponowne wchodzenie w ustawienia oprogramowania uktadowego.

Urzadzenia dla ktérych nie zostata dostarczona aktualizacja oprogramowania uktadowego (BIOS) na
portalu Support.
Pobierz paczke z najnowszymi certyfikatami dla Secureboot 2026:
https://update.ntt.pl/file/1841/9ae3ef068c3af071e5f7cff64006flca
Wypakuj zawartos¢ paczki bezposrednio na pendrive, bagdz inng pamie¢ masowg (moze by¢ réwniez dysk
systemowy, ktory podtaczony jest do urzadzenia jako gtéwny dysk, ale zalecamy uzywac pendrive)
Podtacz pendrive do dowolnego portu USB urzadzenia.

Zrestartuj urzadzenie na ktérym wystepuje komunikat o naruszeniu SecureBoot. Podczas ponownego
uruchamiania od razu zacznij wciskac klawisz ,,Delete” znajdujacy sie na klawiaturze. To pozwoli wejs¢ do
ustawien BIOS.

Przejdz do zaktadki Security:

Aptio Setup - AMI

Chipset | Security | Boot Save & Exit
BIOS Information
Model Name PH610-D4 wZ2.0
Build Date and Time 0141522025 1223552
Access Level Administrator
Jl System HManufacturer MTT System S.A.
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Odszukaj i uruchom funkcje ,,Secureboot”:

Chip

Security

Disable Block Sid [Disable]
Password Description

If ONLY the Administrator's password is set,
then this only limits access to Setup and is
only asked for when entering Setup.

If ONLY the User's password is set,

then this
is a power on password and must be entered to

boot or enter Setup. In Setup the User will
have Administrator rights.

The password length must be
in the following range:
HMinimum length

. R
Maximum length 20
Administrator Password

User Password

Check FPassHord [Always]

| <um

Przetacz funkcje Secureboot Mode ze ,,Standard” na,,Custom”

jystem Mode User
Secure Boot [Enablel
Active

Restore Factory Keus
Reset To Setup Hode

Key HManagement

Aptio Setup - AMI

Security
System Mode User
Secure Boot [Enable]
Active

> Restore Factory Keys
> Reset To Setup Mode

l' Key HManazement

Przejdz do funkcji ,,Key Managment”:

Aptio Setup - AMI

Security
sSystem Mode User
Secure Boot [Enable]
Active
> Restore Factory Keys
> Reset To Setup HMode
>

Key Management
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Przejdz do zaktadki , Key Exchange Keys” klawiszem Enter znajdujgcym sie na klawiaturze urzadzenia:

vendor Keys HModified

Factory Key Provision
Restore Factory Keys

Reset To Setup HMode

Enroll Efi Image

Export Secure Boot variables

[Enable]

v V.Y

Secure Boot wariahle |

Size| Keus| Key Source
» Platform Key

(PK) | 862]| 1] Test(AMI)

» Authorized
» Forhidden
>

Signatures (db) | 3143

2] Factoryg
Signatures (dhx) | 17836 |

371 Factorq}
Authorized TimeStamps (dbt) | o}l 0| No Keys ®
» OsRecowery Signatures(dbr) | 0| 0| Mo Keys

Wybierz opcje ,,Append”:

Aptio Setup - AMI

vendor Keys

Factory Key Provision
» Restore Factory Keuys
» Reset To Setup HMode
» Enroll Efi Image
» Export Secure Boot variables

Secure Boot wariable |
» Platform Key (PK) |

» authorized Signatures (db) |
» Forbidden Signaturesidbx) |1
» Authorized TimeStamps (dbt) |
» OsRecovery Signatures(dbr) |

Modified

[Enable]

Key Exchange Keys

Details
Export
Upndate
Append
Delete

(KEK)

Zaznacz i przejdz do opcji ,,No” za pomocg strzatek na klawiaturze urzadzenia, potwierdzajac wybdr klawiszem Enter

vendor Keys

Factory Key Prowvision
» Restore Factory Keys
» Reset To Setup HMode
» Enroll Efi Image

» Export Secure Boot variables

Secure Boot wvariable
» Platform Key (P
» Authorized Signatures (d
» Forbidden Signatures(db
» Authorized TimeStamps (db
» DsRecovery Signaturesidb

Press 'Yes'

Modif ied

[Enable]

Append

to load factory default
or 'No’ to load it from a
file on ext;rnal media

'KEK '

Wybierz urzadzenie na ktérym znajdujg sie wymagane certyfikaty. Pendrive oraz inne pamieci masowe podtgczone do
portu USB bedg opisane jako ,,USB”. Dyski systemowe podtgczone do wewnetrznych portéw urzadzenia (SATA/M.2)

jako PCIE. Wybor urzadzenia mozliwy jest za pomocg strzatek znajdujacych sie na klawiaturze urzadzenia,

potwierdzenie wyboru, klawisz Enter:
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SYSTEM SecureBoot Windows 2026 Dodawanie Certyfikatéw dla wybranych

Vendor Keys Modif ied

Factory Key Provision [Enable]
> Restore Factory Keus
> Reset To Setup Mode
» Enroll Efi Image

Enroll Factort
load certifics
1.Public Key
a)EFI_SIGNATI

» Export Secure Boot wvariables

Select a File system

b)EFI_CERT Xt
C)EFI_CERT_RS
d)EFI_CERT_SH

PciRoot (0x0) /Pci(0x14,0x0] /USB(0x6,0x0) /HD(1,MBR, 0Xx26C69EEC, 0800, 0x33A2800)

PciRoot (O0x0) /Pci(0x1C,0x0. /Pci(0x0,0x0) /NVMe (0x1,5B-27-D0-6A-A3-A7-79-64)/HD(1,G
PciRoot (0x0) /Pci(0x1C,0x0] /Pcli(0x0,0x0) /NVMe (0%l ,5B-27-D0-6A-A3-A7-79-64) /HD (3, G
PciRoot (0X0) /Pci(0x1C,0x0 /Pci(0x0,0x0) /NVMe (0x1, SB-27-DO0-6A-A3-A7-79-64) /HD (4, GA

Po wybraniu odpowiedniego urzadzenia zawierajacego aktualne certyfikaty nalezy wybrac¢ folder ktéry odpowiada
aktualnie dodawanym certyfikatom. Za pomocg strzatek na klawiaturze podtaczonej do urzadzenia nalezy wybrac

folder z certyfikatem. Potwierdzenie klawiszem Enter:

&

Security

vendor Keuys Modif ied

Factory Key Provision

» Restore Factory Keys

» Reset To Setup HMode

» Enroll Efi Image

» Export Secure Boot variables

[Enablel

Secure Boot wvariable |

Size| Select File
» Platform Key (PK) 862 |
<.>
» Authorized Signatur T 3143 e
» Forbidden Signatures(dbx)|17836| £DEN
» authorized TimeStamps (dbt) | o]
» OsRecowery Signatures(dbr) | (o}l

Nazwa Data modyfikacji Typ Rozmiar

DB
KEK

*Przyktad- Key Exchange Keys (KEK)- folder KEK na urzadzeniu pamieci masowe;j

Po potwierdzeniu wejécia w folder ,,KEK”, nalezy wskazaé za pomoca strzatek znajdujacych sie na klawiaturze

certyfikat aktualnie dodawany, zatwierdzi¢ wybdr klawiszem Enter:

Security

vendor Keus

Modified Enrao

load

Factory Key Prowvision [Enablel 1.P1

» Restore Factoru Keys ajt

» Reset To Setup Mode bJE

» Enroll Efi Image cJE
» Export Secure Boot wvariables

Secure Boot wariable
» Platform Key (PK Select File
» Authorized Signatures (dbj eSS
» Forhidden Signatures (dbx|EEas
» Authorized TimeStamps(dbt

microsoft corporatioﬁ kek 2k ca 2023.crt
» OsRecowvery Signatures (dbr|
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Po potwierdzeniu wybrania certyfikatu nalezy wybraé opcje ,,Public Key Certificate”:

Security

vendor Keus Modif ied
Factory Key Provision

» Restore Factory Keys

» Reset To Setup Hode

» Enroll Efi Image

» Export Secure Boot variables

[Enablel

Secure Boot wariable |

size|
» Platform Key (PK) |

862 | Input File Format

» Aauthorized Signatures (db) | 3143|
» Forbidden Signatures(dbx)|17836]
» Authorized TimeStamps(dbt) | 0|
» OsRecowery Signatures(dbr) | 0|

Public Key Certificate
Authenticated Varliable

0| No Keys

Wcisnac klawisz Enter po pojawieniu sie ponizszego okna:

vendor Keys

Modif ied Enroll F:
load cert
Factory Key Provision [Enable] 1.Public
» Restore Factory Keus a)EFI_S
» Reset To Setup Hode bJEFI_C
» Enroll Efi Image ) ERTNG]
» Export Secure Boot variables d)EFI_CE
2.Authent

Secure Boot variable |

Size| Keys| Key Source 3.EET PE
» Platform Key
Enter Certificate Owner GUID
> AUThOrized Signat Ur e s
» Forbidden Signatures GUID [26DC4851-195F-4QE 1-9A19-FBF883BBB35E]
» Authorized TimeStamps)

» OsRecowvery Signatures(dbr) | o] 0| No Keys

Zaznacz i przejdz do opcji ,,Yes” za pomocg strzatki na klawiaturze urzadzenia, potwierdzajgc wyboér klawiszem Enter.

vendor Keus

Modif ied Enrol]
load c
Factory Key Provision [Enable] 1.Pub
» Restore Factory Keus a)EF
» Reset To Setup Hode b)EF
» Enroll Efi Image C)EF
» Export Secure Boot variables d)EF:
2.Autk

Secure Boot variable

Append
» Platform Key (P
Press 'Yes' to update 'KEK' with content
from microsoft corporation kek 2k ca
2023.&Pt

» Authorized Signatures (d
» Forbidden Signatures(db
» Aauthorized TimeStamps (db
» 0OsRecovery Signatures(db
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Potwierdz sukces klawiszem Enter.

Aptio Setup - AMI

Security

vendor Keys Modif ied
Factory Key Prowvision [Enablel]
» Restore Factory Keys
» Reset To Setup Mode
» Enroll Efi Image
» Export Secure Boot variables

Secure Boot wvariahle | Size| Keys|
» Platform Key

Key Source
(PK) | 862 | 1]

Append

» Aauthorized Signatures (db) | 3143 2|
» Forbhidden Signatures(dbx)|17836| 371]|
» Authorized TimeStamps(dbt) |

0| 0}
» OsRecovery Signatures(dbr) | o] o

Success

Jesli pojawi sie komunikat ,,Failed”- powtérz caty proces dodawania certyfikatu od miejsca uruchomienia funkgcji ,,Key
Exchange Keys”.

Po poprawnym dodaniu mozna zauwazyg, ze status ,Key Source” zmienit sie na mixed.

vendor Keys Modif ied

Factory Key Provision [Enablel
Restore Factory Keys

Reset To Setup HMode
Enroll Efi Image

Export Secure Boot wvariables

yYYY

Secure Boot wvariable
Platform Key

| size| Keys| Key Source
(PK) | 862 | 1| Test(AHMI)
b

Authorized Signatures (dbh) | 3143 2] Factory
» Forbidden

Signatures(dhx) |17836 |

Szl Factorwk
» Authorized TimeStamps(dbt) | (o}l 0| Mo Keys
» 0OsRecovery Signatures(dbr) | o}l 0| No Keys

W celu upewnienia sie, ze certyfikat zostat dodany prawidtowo, zalecamy przejs¢ ponownie do funkcji ,Key Exchange
Keys” a nastepnie uruchom opcje ,Details”:

Security

vendor Keys

Modif ied
Factory Key Provision [Enable]
Restore Factory Keys
Reset To Setup Mode
Enroll Efi Image

Export Secure Boot variables

vyYyyy

Secure Boot variable
Platform Key

Key Exchange Keys
(PK) |

Details
EXpOrt
Update
Append
Delete

» Authorized
» Forbidden

» Authorized
» OsRecowery

Signatures (db) |
Signaturesi{dbx) |1
TimeStamps (dbt) |
Signatures{dbr) |
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Certyfikat KEK 2K CA 2023 powinien znajdowac sie na liscie:

Aptio Setup - AMI
Security

Vendor Keys Modified Enroll Factory Defau)
load certificates frg
Factory Key Provision [Enable]
» Restore Factory Keys

1.Public Key Certifi
a)EFI_SIGMATURE_LIS
b)EFI_CERT_X509 (DEFf
C)EFI_CERT_RSAZ2048 (
d)EFI_CERT_SHAXXX
2.Authenticated UEFI

» Reset To Setup Hode
» Enroll Efi Image

» Export Secure Boot wariables

Key Exchange Keys (KEK)

List| Sig.Type|Count| Size| Owner GUID
11 %.s039 | 1| 1516| 77FA9ABD-.., | Microsoft Corporation KEK CA 2011
S Er ] 1| 1462| 26DC4851-...'| Microsoft Corporation KEK ZK LA zUzs

| certificate Legend

Jesli nie jest widoczny, nalezy ponownie przej$¢ proces dodawania certyfikatu zaczynajac od funkcji ,,Key Exchange
Keys”.

Analogicznie nalezy dodaé pozostate trzy certyfikaty znajdujace sie na urzadzeniu do ktdorego zostaty wypakowane, za
pomoca funkcji ,Authorized Signatures (db)”.

vendor Keus Modified
Factory Key Provision

» Restore Factory Keys

» Reset To Setup Mode

» Enroll Efi Image

» Export Secure Boot variables

[Enable]

Secure Boot wariable |

Size| Keys| Key Source
» Platform Key

(P | B62] 1| Test(AMI)

» Authorized Signatures (db) | 3143

2| Factory |
» Forbidden Signaturesidbx) 17836 371 Factory
» Authorized TimeStamps(dbt) | 0| 0] Mo Keys ®

» OsRecovery Signaturesidbr) | 0|

0| No Keys

Vendor Keys Modif ied

1
Factory Key Provision [Enable]
Restore Factory Keys

Reset To Setup Mode
Enroll Efi Image

EXport Secure Boot wvariables

Secure Boot variable |
Platform Key (PK) |

Key Exchange Keys (KEK) | Details

Export
Signatures (dbx) | 1) EEGESES

Authorized TimeStamps (dht) | Append
» OsRecovery Signatures(dbr) | velele

Authorized Signatures (db)

» Forbidden
»>

Dokument jest wtasnoscig NTT System S.A. (The document is the property of NTT System S.A). Str/page. 9



®
SYSTEM

produktéw NTT

SecureBoot Windows 2026 Dodawanie Certyfikatow dla wybranych

vendor Keys

Factory Key Prowvision
Restore Factory Keys

Reset To Setup Hode

Enroll Efi Image

Export Secure Boot wvariables

vvyvYy

Secure Boot variable
» Platform Key
» Key Exchange Keys

» Forbidden Signatures(dbx
» puthorized TimeStamps (dbt
» OsRecowvery Signatures(dbr

Press

HModified Enrol

load
1.Pu
aE
blE
CJEI
d)El
2.Aul

[Enable]

Append

'ves' to load factory default 'db’
or 'No' to load it from a

file on extgrnal media

Aptio Setup - AMI

Security

vVendor Keys

Factory Key Provision
Restore Factory Keuys
Reset To Setup Mode
Enroll Efi Image
Export Secure Boot variables

| d
>
>
>

Modified Enroll Factort

load certifics
1.Public Key

a)EFI_SIGNAT
b)EFI_CERT_Xt
C)EFI_CERT_RS
d)EFI_CERT_SH

[Enable]

Select a File system

PciRoot (0x0) /Pci(0x14,0x0] /USB(0x6,0x0) /HD (1, MBR, 0Xx26C63EEC , 0800, 0x39A2800)

PciRoot (0x0) /Pci(0x1C,0x0] /Pci(0xX0,0x0) /NVMe (0x1,5B-27-DO0-6A-A3-A7-79-64) /HD(1,G

PciRoot (Ox0) /Pci(0x1C,0x0; /Pci(0x0,0x0) /NVMe (0x] ,5B-27-D0-6A-A3-A7-79-64) /HD (3, Gf
PciRoot (0x0) /Pci(0X1C,0%x0, /Pci(0x0,0x0) /NVMe (0x1', SB-27-DO0-6A-A3-A7—-79-64) /HD (4, GA

Aptl1o Setup - AMI

Security

Vendor Keys

Factory Key Prowvision
Restore Factory Keys
Reset To Setup Hode
Enroll Efi Image

vyyYyvyy

Secure Boot wariable |
Platform Key (PK) |
Key Exchange Keys KFEK) |

vy

» Forbidden Signatures(abers|17836|
» Authorized TimeStamps(dbt) | 0|
» OsRecovery Signatures(dbr) | 0|

Modif ied

[Enable]

Export Secure Boot variables

Size|
862 |
3066 |

Select File

Nazwa Data modyfikacji Typ

-“ £

KEK

Rozmiar

Folder plikow

*Przyktad- Authorized Signatures (db) folder DB na urzgdzeniu pamieci masowej

Dokument jest wtasnoscig NTT System S.A. (The document is the property of NTT System S.A).
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Uwaga, funkcja Authorized Signatures (db) wymaga dodania trzech certyfikatéw. Dlatego caty proces nalezy
powtdrzy¢ oddzielnie dla wszystkich trzech certyfikatéw znajdujacych sie w folderze ,,DB”:

H J = W] e =
Security

vendor Keus Modified Enroll
load c

Factory Key Prowvision [Enable] 1.Pub
» Restore Factory Keus a)EF
» Reset To Setup Mode bJ)EF.
» Enroll Efi Image cIEFR]

» Export Secure Boot wvariables

Secure Boot variable
» Platform Key (PK)

Select File

» Key Exchange Keys (KEK ) | IR

» Forbidden Signatures(dbx)

< S

windows uefi ca 202g.crt

» Authorized TimeStamps (cdbt) | EEIETelalet=a) & SMVI-E 3 B ot Wb=J0 =i Bl ol gl o

» OsRecovery Signatures (dbr)

microsoft option rom uefi ca 2023.crt

Security

vendor Keys

Factory Key Provision
» Restore Factory Keys
» Reset To Setup Mode
» Enroll Efi Image
» Export Secure Boot wvariables

Secure Boot wvariable | size]|
» Platform Key (PK)| 862]|
» Key Exchange Keys (KEK) | 30866 |

» Forhidden Signatures(dbx) |17836 ||REGIERda-IgheTat-Rd-
» Authorized TimeStamps(dbt) | ell| EFI PE/COFF
» OsRecowveruy Signatures(dbr) | 0|

Modif ied

[Enable]

Input File Format K

Public Key Certificate
variapie —
mage

—

Vendor Keys

Factory Key Provision

» Restore Factory Keys

» Reset To Setup Mode

» Enroll Efi Image

» Export Secure Boot wvariables

Secure Boot wvariable |
» Platform Key e :
» Key Exchange Keys

» Forbidden
» Authorized TimeStamps
» OsRecowery Signatures(dbr) |

Modified Enroll Fac

load certi
1.Public ¢
a)JEFI_SIC
b)EFI_CER
CJEFI_CER
d)EFI_CER
2.Authent it
= ERIERBEZE(

[Enable]

Size| Keys| Key Source

Enter Certificate Owner GUID

Signatures GUID [26DC4851-195F-4QE1-9A19-FBF883BBB35E]

(e} 0| Mo Keys

Security

vendor Keys

Factory Key Provision
Restore Factory Keys
Reset To Setup HMode
Enroll Efi Image
Export Secure Boot variables

v Y Y

Secure Boot wvariahle
» Platform Key
» Key Exchange Keys

» Forbidden
» Authorized TimeStamps (db ——————————————3

» OsRecovery Signatures(db

Modified

[Enable]

Append

Press 'Yes' to update 'db' with content

from windows uefi ca 2023.crt
Signatures(db
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Po wybraniu ,, Yes” i potwierdzeniu informacji o sukcesie, nalezy ponownie przejs¢ do funkcji Authorized Signatures
(db) i wykonac te same kroki dla pozostatych certyfikatow znajdujgcych sie w folderze ,,DB” w taki sposéb, aby po
wejsciu do zaktadki ,, Details” znajdowaty sie wszystkie zaznaczone ponizej certyfikaty:

vendor Keus Modif ied
Factory Key Provision

» Restore Factory Keys

» Reset To Setup Mode

» Enroll Efi Image

» Export Secure Boot variables

[Enablel

Secure Boot wvariable |

Key Exchange Keys
> Platform Key (PK) |

(KEK)
Details

EXpOrt

Update

Append

Delete

» Authorized Signatures (dh) |
» Forbidden Signaturesi(dbx) |1
» Aauthorized TimeStamps (dbt) |
» OsRecowvery Signatures(dbr) |

Security
Vendor Keys Modif ied Enroll Factory Defaults
load certificates from z
Factory Key Provision [Enable] 1.Public Key Certificat

» Restore Factory Keus
» Reset To Setup Mode
» Enroll Efi Image

Size|
1556 |
1493
1454 |
1448/
1459 |

X.509

X.509
X.509
X.509

a)EFI_SIGNATURE_LIST
b)EFI_CERT_X5039 (DER)
Cc)EFI_CERT_RSA2048 (bil

Authorized silgnatures (ao)

Owner GUID | Certificate Legend

77FASABD-...| Microsoft Corporation UEFI CA 2011
77FASABD-...| Microsoft Windows Production PCA 2011
26DC4851-...)J) Hindows UEFI CA 2023

26004851—...* Microsoft UEFI CA 2023

26DC4851—. .. | Microsoft Option ROM UEFI CA 2023

Na liscie moga znajdowac sie réwniez inne certyfikaty, ale wazne jest aby lista zawierata wymienione wyzej

certyfikaty.

Po poprawnym dodaniu mozna zauwazyc, ze status ,Key Source” zmienit sie na Mixed i zawiera minimum 5 kluczy
(moze byc wiecej).

vendor Keyus

Factory Key Provision
» Restore Factory Keys
» Reset To Setup HMode
» Enroll Efi Image

Modif ied

[Enable]

» Export Secure Boot variables

Secure Boot variahle | size| Key Source
> Platform Key (P 862] Test (AMI)
Key Exchange Keys (KEK) | 30686 | Mixed

» Forbidden

Dokument jest wtasnoscig NTT System S.A. (The document is the property of NTT System S.A).

Sighatures(dbx) | 17836 |
» Authorized TimeStamps(dbt) |
» OsRecowery Signatures(dbr) |

371 FaCtOPyQX
0| 0| No Keys ®
0| 0| Mo Keys
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Jesli zawiera, nalezy klawiszem ,,F10” zapisa¢ zmiany.

Aptlo Setup - AMI

Vendor Keys

» Forbidden
» Authorized
» OsRecovery

Modif ied Enrc
load
Factory Key Provision [Enablel it [
» Restore Factory Keys a)
» Reset To Setup Mode bt
» Enroll Efi Image clt
» Export Secure Boot variables d)E
2.AL
Secure Boot variable | Size| Keys| Key Source
» Platform Key (PK) | Save & Exit Setup
» Key Exchange Keus (KEK) |

Save configuration and exit?
Signatures (dbx) | 1783

TimeStamps (dbt) | —J
signatures (dbr) |

Po przeprowadzonej recznej aktualizacji, system Windows powinien sie uruchomic¢ bez czerwonego komunikatu.

Uwaga, kazde zatadowanie ustawien fabrycznych usunie recznie dodane certyfikaty.

Dokument jest wtasnoscig NTT System S.A. (The document is the property of NTT System S.A).
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